Chapter 8

Cost Markups and Adjustments
In M32, cost markups are defined as all of the percentages and adjustments added to
the base Direct Costs in an estimate. Markups can include overtime adjustments,
taxes, and price adjustments, as well as contractor and subcontractor markups, and
owner cost adjustments.
This chapter presents an overview of the process of defining cost markups, explains
the concepts involved in defining and computing markups, and presents reference
information on the M32 windows and tabs used.
• Cost Markups and Adjustments Overview
• Overtime
• Adjustments and Taxes
• Contractor Markups
• Owner Markups
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Cost Markups and Adjustments Overview
M32 allows you to apply multiple-levels of cost markups and adjustments, to any task or
folder in an estimate.

Markups Form
By highlighting any task or folder in the sheet or tree panel and then displaying the Markups
form, you can view or change the markup information for that task or all tasks below that
folder.
To display the Markups form
1

In the Project Database, highlight any folder or task in the tree panel or sheet panel.

2

Choose View > Forms > for Markups, or click the

toolbar button.

Buttons and Controls
The Markups form provides these buttons and controls on all of its tabs.
Task
Count
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This field shows the number of tasks included beneath the currently
selected folder (or “1” if the current selection is a task). This field is
displayed for all the tabs of the Markups form.
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Back

Display the Markups form for the previous task or folder in the
database.

Next

Display the Markups form for the next task or folder in the database.

Apply

Apply any changes you have made on the form, and leave the form
displayed.

Close

Apply any changes you have made on the form, and close the form.
Tip: You can also click the X icon in the upper right corner to close the
form. This method removes the form from memory and as a result
frees system resources. However, the form will be slower to reload
than if you click the Close button.

Summary Tab - How Markups Are Applied
As illustrated in the figure above, the Summary tab on the Markups form shows the
computed markup costs for the folder or task currently selected in the tree or sheet
panel.
The grid area summarizes the markups applied to each Direct Cost type in the
estimate, beginning on the top row with Bare Direct Costs and proceeding down to
Total Project Cost at the bottom.
1

Bare Direct Costs are the base costs recorded for a task, before any markups or
adjustments.

2

Costs applied to Bare Direct Costs can include price adjustments and taxes. Added to
bare costs, these markups equal the "full direct cost" for any task or folder; that is, the
cost to the sub or prime contractor who performs the work.

3

Next, overhead, profit, and other contractor markups are applied for each contractor
involved in the work. M32 allows you to define multiple levels of tiered contractors in an
estimate. A subtotal line shows the Costs to the Prime Contractor.
Note: Subcontractors are listed by name unless all of the tasks below the selected item
do not have the same subcontractor. In this case, a generic Subcontractors line is used
to summarize all subcontractor markups.

4

The Prime Contractor's own markups are then shown, with the next line of subtotals
being the Total Contract Cost or Cost to Owner.

5

Lastly, costs outside the contract, known as Owner Costs, are applied to result in the
bottom line cost, referred to as the Project Cost.
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Defining Markups and Adjustments
Defining markups and adjustments in M32 involves the following tasks:
Task
1

Description
You choose the cost type fields used for markups on the Select
Fields tab of the Project Summary Information dialog. These fields
can include predefined cost types that M32 computes in specific
ways, or cost types that you define.
Refer to Chapter 4 for more information on the Project Summary
Information dialog and the cost types.

2

In the case of contractor markups, you add contractors in the
Contractors primary view, and then assign tasks to them.
Refer to “Contractor Markups” in this chapter.

3

For non-contractor markups, you use the Markups form to define the
actual cost amounts or percentages to apply as markups. In some
cases you will define markups that apply to the estimate as a whole.
In other cases, you will want to define specific markups that apply
only to a certain task or folder.

Caution on Applying Markups to Folders
If you apply markups to a folder and later add more tasks to that folder, your markups
will not be automatically applied to the new tasks. You must manually reapply the
markups. You can run the Markups report to see which markups are applied to
specific tasks.
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Overtime
Overtime adjustments are typically applied to the Labor (and sometimes
EquipmentDirect cost types. They are applied before all other markups.
You define Overtime adjustments on the Overtime tab.

Effects on Labor and Equipment Costs
When you apply an Overtime adjustment, M32 marks up the Labor costs for all affected
tasks by that percentage. Equipment costs are affected only if you are using the U.S. Army
Corps of Engineers equipment cost calculations as displayed on the equipment form (See
Chapter 7). In this case, the Ownership (FCCM) portion of the equipment cost for each task
is reduced by the percentage shown in the Equip FCCM % field on the Overtime tab.

Overtime Categories
M32 uses data that you enter on the Overtime tab to create Overtime categories. These
categories define the amount of overtime worked and the overtime differentials to be applied.
Based on this data, M32 computes an overtime percentage adjustment to be applied to all
Labor costs (and an Equipment FCCM percentage to be applied to Equipment costs) when
this Overtime category is applied.
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Field Descriptions
Overtime
Categories Area

The grid area in the upper left part of the tab shows all of
the Overtime categories that have been defined for this
estimate. The currently selected category is shown by
the
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icon

Count

Number of tasks under the currently selected folder that
use this Overtime category. These tasks are displayed
in the tasks grid, below.

Overtime
Category

Description of the Overtime category

Percent

Percentage added to labor costs by this Overtime
category.

Configuration
Area

The area in the upper right shows the values used to
compute the Overtime percentage for the currently
selected Overtime category

Days Grid

The days included in the workweek and the amount of
Overtime adjustment for each day

Shifts Grid

The shifts worked and the number of hours in each shift

Hours per Day

Total hours per day (the sum of the hours for the
specified shifts)

Equipment FCCM
%

Percentage by which the Ownership component of
Equipment costs will be reduced (when using the U.S.
Army Corps of Engineers method of computing
Equipment costs)

Standard Work
Day

Number of hours in a standard work day. That is, the
number of hours per day paid at the standard, nonovertime rate.

Standard Work
Week

Number of days in a standard week. That is, the
number of days per week paid at the standard, nonovertime rate.

Tasks Grid

The grid area at the bottom of the tab shows all tasks
below the currently selected folder to which the selected
Overtime category is currently applied. The tasks are
shown with their parent folders and the associated Tags.
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Actions
You can take the following actions from the Overtime tab:
• To apply the selected Overtime category to the current task or all tasks under the currently
selected folder, click the Apply or Close buttons.
• To change the way Overtime is computed for the selected category, change the values in
the Configuration area and click Apply or Close. This updates Overtime adjustments for
all tasks to which this category has been applied.
• To add an Overtime category, click the blank Overtime Category field. Enter a name in
the Overtime Category field and then click another field on the grid. You can then select
values in the Configuration area. To apply the Overtime percentage to the current folder
or task, click apply. To exit without applying, click Close.

Example - Adding Overtime to Part of an Estimate
In this example, you need to define an Overtime category and apply it to all Roofing tasks in
your estimate.
1

In the tree panel, highlight the folder for Roofing.

2

Choose View > Form > for Markups.
The Markups form is displayed.

3

Click the Overtime tab.

4

Click on the first blank row in the Overtime Categories area. Type “Overtime” in the
Overtime Category field and then click on another field in the same grid.
M32 enters 0.00% in the Percent field. You can now access the Configuration area for
the new category.
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5

Enter the following information in the Configuration area
Day Working

Select all

Paid At

Enter 2.0 for Sunday and 1.5 for all other
days.

Shifts Working

Select #1 and #2

Shifts Hours

Enter 8.0 for #1 and 7.5 for #2

Note: Do not change the other default values.
M32 computes the Hours per Day as 15 and computes the overtime percentage as
25.35%. It places this value in the Percent field in the Categories area. It also computes
an Equipment FCCM percentage of - 63.13%.
6

Click the Apply button.
M32 applies an Overtime markup of 25.35% to the labor costs of all tasks under the
Roofing folder. If you are using the Corps of Engineers’ equipment cost computations,
M32 also reduces the Ownership component of the equipment by 63.13%.
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Adjustments and Taxes
Cost adjustments are any percentage markups that you may wish to apply to a task
or folder in an estimate. Taxes normally represent sales tax on material and are
applied to the Material Direct Cost type . Both adjustments and taxes are applied
after any Overtime percentages and before contractor markups.
You define information for these markups on the Adjustments and Taxes tab.

Adjustment/Tax
Type

This area in the upper left part of the tab shows all of the
adjustment and tax markups defined for the estimate.
These are the same as the Adjustment/Taxes types
selected on the Project Summary Information dialog,
Select Fields tab. The currently selected type is shown
by the

icon

Definition Grid

The grid area in the upper right shows the values for the
currently selected adjustment or tax.

Count

Number of tasks under the currently selected folder that
have this adjustment applied. These tasks are displayed
in the tasks grid, below.

Description

Description of the adjustment, (typically includes the
percentage added or deducted and why).

Percent

Actual numeric percentage of the adjustment

M32 Reference Manual

185

Chapter 8 : Cost M arkups and Adjustments

Tasks Grid

The grid area at the bottom of the tab shows all the
tasks under the currently-selected folder to which the
selected tax or adjustment is applied. The tasks are
shown with their parent folders and associated Tags.

Actions
You can take the following actions from the Adjustments and Taxes tab:
• To apply the selected tax or adjustment to the current task (or all tasks under the
currently-selected folder) click the Apply button.
• To change the way the tax or adjustment is computed, change the values in the Definition
Grid and click Apply. This updates the markup for all tasks in the estimate to which this
tax or adjustment has been applied.

Example - Defining Sales Tax for Materials
In this example, you need to define a 5.5% sales tax for all materials in your estimate. The
example assumes you have selected a Direct Cost type of Material and an
Adjustments/Taxes type of Sales Tax on the Select Fields tab of the Project Summary
Information dialog.
1

Highlight the top level folder for your estimate.

2

Choose View > Form > for Markups.
The Markups form is displayed.

3

Click the Adjustments and Taxes tab.

4

In the Adjustments/Tax Type area, click to select Sales Tax (if it is not already selected).

5

Enter the following information:

6

Description

5.5% Sales Tax on Material

Percent

5.5%

Click the Apply button.
M32 applies the tax . All Material costs in the estimate are increased by 5.5%.
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Contractor Markups
M32 offers great flexibility in defining and applying contractor markups. Contractors'
overhead, profit, and bond costs are figured individually for each contractor involved
in the project. The software automatically calculates these costs according to any of
a number of methods that you choose. You can apply markups for individual
contractors to any folder or task at any level in the project hierarchy.
Contractor markups are typically applied to all Direct Cost types. They are applied
after Overtime, taxes, and cost adjustments, but before Owner Cost markups.

Contractor Tiering
Prime and Subcontractors
In M32, a prime contractor is defined as one who does not work for another
contractor. A subcontractor is one who does work for another contractor.
M32 allows you to have more than one prime contractor defined in the project. M32
also permits you to define multiple levels of subcontractors, as in the following
example.
Level 1 - BC Building Construction (Prime Contractor)
Level 2 - EL Electrical (Subcontractor)
Level 3 - ES Electrical Specialties (Subcontractor)
In this example, Contractor ES works for Contractor EL, who in turn works for
Contractor BC. BC is a prime contractor, because he does not work for any other
contractor. BC is also considered the parent contractor to his subcontractor EL.
Similarly, EL is considered the parent contractor to his sub, ES.

Compounded Cost Markups
When M32 calculates the estimate, a subcontractor's cost markups are rolled in to
the costs applied to the parent contractor.
In the above example, the costs for work performed by ES will be applied to EL with
ES's markups included. Similarly, the costs for the same work will be applied to BC
with both ES's and EL's markups included.
In other words, M32 compounds the markups of tiered contractors, as is common
construction practice.
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Task List for Working with Contractor Markups
Working with contractor markups in an M32 estimate involves the following tasks:
Task
1

Description
You use the Project Summary Information dialog, Select Fields tab, to
select the Contractor Markup cost types and the types of Direct Costs
they apply to.
Refer to Chapter 4 for information.

2

You add the contractors to the Project Database, using the
Contractors primary view.

3

You apply the contractors markups to folders or individual tasks in the
estimate. By doing so you assign the folders or tasks as work
performed by that contractor.

Contractors Primary View
You use the Contractors primary view of the Project Database to add contractors and to view
the hierarchy of contractors in your estimate. This view is automatically created with the
Project Database. It contains only a default Prime Contractor folder and an Unassigned
folder until you add contractors.
NOTE: Every contractor in the view is created with two subfolders, called Overhead and Own
Work. These folders are explained below.
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Defining Prime Contractors
You can use the default folder to define the first prime contractor in your estimate. If you have
multiple prime contractors, you can add folders for them at the same level.
1

Select the default prime contractor folder in the tree panel.

2

To define information for the first prime contractor, click the right mouse button and
choose Edit Folder from the context menu.
The Contractor form appears (see below).

4

Fill in the form with the contractor information.

5

Click Close to exit the form.

NOTE: To add another prime contractor at the same level, select the prime contractor folder
in the tree panel and choose Insert > Folder. Then select the New Folder and repeat
the procedure from Step 2.

Adding Subcontractors
You add subcontractors as folders below the prime contractor folder. The subcontractors are
thus defined as “child” folders to the prime contractor. As explained under “Contractor
Tiering,” above, you can define multiple levels of subcontractor folders representing “parent”
and “child” contractors.
1

In the tree panel, select the folder for the parent contractor under which you want to
define the subcontractor.

2

Choose Insert > Child Folder.
The New Folder appears in the tree panel.

3

Select the New Folder, click the right mouse button, and choose Edit Folder from the
context menu.
The Contractor form appears (see below).

4

Fill in the form with the contractor information.

5

Click Close to exit.

M32 Reference Manual

189

Chapter 8 : Cost M arkups and Adjustments

Contractor Form
You use the Contractor form to add or edit information about a contractor.

General Tab
Contractor
Definition
Contractor ID

Required code you assign to identify this contractor.
See “Suggested Contractor IDs”, below.

Quantity/UOM

Optional. Quantity and unit of measure associated with
this contractor's work. Often, 1 LS (lump sum) is used.
Actual quantities may also be used.
By filling in this field you enable M32 to calculate a unit
cost for all work done by this contractor independent of
the unit costs of any particular task or folder.
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Contractor Name

Name of the contractor

Short Name

Short version of the contractor name, as used on the
tree panel

Folder Tag

Optional tag or code associated with this contractor
folder in the contractor hierarchy
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Project
Contractor
Summary

The grid area shows the summary of cost markups for
this contractor

Markup

The Contractor Cost fields selected for this estimate on
the Project Summary Information dialog, Select Fields
tab.
Refer to Chapter 4 for information.

Method

The method used to compute the contractor's markup
for each Cost field. See “Cost Methods” below for
information.

Own%

Percentage markup for this Cost field applied to the
Contractor's own work

Sub%

Percentage markup for this Cost field applied to the
Contractor's subcontracted work

Amount

Amount of markup for this Cost field.
Note: Depending on the Cost Method, either an Amount
or Percentages may be used.

Cost Methods
M32 supports these methods of computing contractor markups. As indicated, certain
methods are only available for certain of the predefined Contractor Cost fields.
• Direct Pct - M32 calculates the markup using the percentage you enter in the Own % field
times the contractor's Direct Costs only. The same percentage is applied to the
contractors own and subbed work. This option is available for all Contractor Cost fields.
• Running Pct - M32 calculates the markup based on the percentage you enter in the Own
% field times the running total. (The running total is the total of the contractor's Direct
Costs plus the values of any Cost fields appearing above the present row in the grid.)
The same percentage is applied to the contractors own and subbed work. This option is
available for all Contractor Cost fields.
• Separate Pct - M32 calculates the separate markups for the contractor’s own work and
subbed work, using the two separate percentages that you enter in the following fields.
This option is available only for the Overhead and Profit Cost fields.
• Amount - Add the amount that you enter in the Amount field. This option is available for
all Contractor Cost fields.
• Compute Overhead - Choose this option when you want to estimate the contractor's
overhead using tasks that you enter specifically for this contractor. See "Working With
Overhead Tasks," below. This option is available for the Overhead Cost field only.
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• Compute Profit - Choose this option when you want to compute the contractor's profit
using the Profit Weighted Guidelines table. See “Profit Tab,” below, for information. This
option is available for the Profit Cost field only.
• Bond Class Options - Choose these options when you want M32 to compute a bond
markup amount using a predefined Bond table and Bond Classes, which are maintained
by the M32 Administrator. These options are available for the Bond Cost field only.
Note: Administrators maintain the Bond Table using the M32 Administrator Module. If
you are an administrator, see Appendix A..
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Suggested Contractor IDs
Following is a list of recommended contractor IDs for common types of contractors:
AA – Prime Contractor
AB – Alternate Prime
AC – Acoustic Treatment
CA - Carpeting
CO - CO2 Fire Protection System
CS - Special Coating
CW - Cabinet and Casework
EL - Electrical
ES - Special Electrical Systems
EV - Elevators
FP - Fire Protection
FS - Food Service Equipment
FU - Furnishings
GL - Glass and Glazing
GW - Gypsum Wallboard
HA - Halon Fire Protection System
HC - Hoist and Cranes
HV - HVAC
IN - Insulation
LP - Lath, Plaster, Stucco
MA – Masonry
MB – Prefab Metal Buildings
MC – Controls
ME – Mechanical
MI – Instrumentation

MR – Membrane Roofing
PA – Partitions
PC - Precast Concrete
PL - Plumbing
PR - Preform Roofing, Siding
PS - Painting and Sealants
RF - Resilient Flooring
SC - Ceiling Suspension Systems
SD - Special Doors
SF - Special Flooring
SM - Sheetmetal
SR - Shingles, Roofing Tiles
SS - Structural Steel
ST - Soil Treatment
SW - Sitework
TB - Test and Balance
TE - Terrazzo
TF - Pile, Foundations
TI - Tileproof, Waterproof
WC - Wall Covering
WD - Windows
WF - Wood Flooring
WP - Dampproof, Waterproof
WW - Entrances, Windowwalls

Working With Overhead Tasks
When you choose Compute Overhead as the cost method for the Overhead cost
field, M32 will compute the Overhead amount by totaling the costs contained in
overhead tasks, which you enter for the contractor. Like other tasks in the estimate,
these tasks may include crews, assemblies, labor, and equipment, as well as CSI
tasks.
You enter these tasks in the Contractor primary view, under the sub-folder called
Overhead Items, which is automatically created when you add each contractor. You
can add as many levels of folders under the Overhead Items folder as you wish.
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To enter Overhead costs for a contractor do any of the following
• Drag tasks from a CostBook, Assemblies, or another Project Database and drop them on
the Overhead Items folder
• Drag and Drop folders from other Project Databases onto the Overhead Items folder
• Insert tasks directly under the Overhead Items folder
• Insert folders under the Overhead Items folder, and then add tasks under those folders
NOTE: Computed Overhead tasks appear at the beginning of the Detail Report.

Profit Tab
Use this tab to estimate the contractor’s markup for profit using a profit weighted
guidelines table. This table is provided as part of M32’s support for U.S. Department
of Defense estimating procedures.
To use the table, you enter a decimal value for each factor listed. M32 multiplies
these values by the weights assigned to each factor to yield a profit percentage for
that factor. These individual profit percentages are totaled at the bottom of the
screen, and the sum is the profit percentage applied for the contractor.
NOTE: The weights listed for each factor can be adjusted by your System Administrator
through the Settings tab on the Administrator Options dialog.
The following guidelines for each weighting factor are copied from the Engineer
Federal Acquisition Regulation Supplement (EFARS).
Risk

Degree of risk. Where the work involves no risk or the
degree of risk is very small, the weighting should be .03;
as the degree of risk increases, the weighting should be
increased up to a maximum of .12.
Lump sum items will have, generally, a higher weighted
value than unit price items for which quantities are
provided. Other things to consider: the portion of the
work to be done by subcontractors, nature of work,
where work is to be performed, reasonableness of
negotiated costs, amount of labor included in costs,
whether the negotiation is before or after performance of
work, etc.
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Difficulty

Relative difficulty of work. If the work is most difficult
and complex, the weighting should be .12 and should be
proportionately reduced to .03 on the simplest of jobs.
This factor is tied in to some extent with the degree of
risk. Some things to consider: the nature of the work,
by whom it is to be done, where, what is the time
schedule, etc.

Size

Size of job. All work not in excess of $100,000 shall be
weighted at .12. Work estimated at between $100,000
and $5,000,000 shall be proportionately weighted from
.12 to .05. Work from $5,000,000 to $10,000,000 shall
be weighted at .04, and work in excess of $10,000,000
at .03.

Period

Periods of performance. Jobs in excess of 24 months
are to be weighted at .12. Jobs of lesser duration are to
be proportionately weighted to a minimum of .03 for jobs
not to exceed 30 days.

Contractors
Investment

To be weighted from .03 to .12 on the basis of below
average, average, and above average. Things to
consider: amount of subcontracting, mobilization
payment item, Government-furnished property, method
of making progress payments, etc.

Assistance

Assistance by Government. To be weighted from .12 to
.03 on the basis of average to above average. Things to
consider: use of Government-owned property,
equipment and facilities; expediting assistance, etc.

Subcontracting

To be weighted inversely proportional to the amount of
subcontracting. Where 80% or more of the work is to be
subcontracted, the weighting is to be .03 and such
weighting proportionately increased to .12 where all work
is performed by the contractor's own forces.
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PT&I Tab
Use the PT&I tab to calculate a percentage to mark up the contractor’s labor costs to
account for payroll taxes and insurance. This percentage is applied to all labor costs
assigned to the contractor and is used to determine the value of the PTI Contractor
Cost field.
FICA (SS tax)

Percentage to markup the contractor’s labor costs for
FICA

Unemployment /
Federal

Percentage markup for Federal Unemployment
insurance

Unemployment /
Federal

Percentage markup for State Unemployment insurance

Workmen’s
Compensation

Percentage markup for Workmen’s Compensation
insurance

Total Payroll
Taxes and
Insurance

Total markup. Equals the sum of the preceding fields.

Contractor’s Own Work Folder
The Own Work folder is automatically created for each contractor that you add. This
folder shows the hierarchy of subfolders and tasks representing work performed by
this contractor (as opposed to subcontractors). This folder is empty until you assign
work to the contractor.

Assigning Work to a Contractor
When you assign work to a contractor, M32 applies the defined markups for that
contractor to the costs of the work. You can assign work to a contractor using several
methods.
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•

You can drag tasks or folders from another primary view of the project to the
Contractors view and them drop them on the Contractor’s Own Work folder. This
is the easiest and recommended method.

•

For individual tasks, you can use the Accounts tab of the task form to select the
contractor.

•

For individual tasks, you can type the Contractor ID in the sheet panel.
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Result: After you have assigned a task or folder to a contractor, you can select that
task or folder in the sheet panel and then view the contractor markups on the
Contractors tab of the Markups form.

Contractors Tab, Markups Form
You use the Contractors tab on the Markups form to view the contractor markups for a
particular project folder or task. Unlike the other tabs on the form, you can view markups
here but not change them.

Contractors grid

The grid in the upper part of the tab shows all of the
contractors defined for the estimate, along with the
following information. The currently selected contractor
is shown by the

icon

Count

Number of tasks under the current folder that this
contractor is currently responsible for

Tag

Code or database ID used to identify this contractor in
the database

Contractor

Name of the contractor
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Work

Total costs of all tasks within the current folder assigned
to this contractor. (These are the Direct Costs to the
contractor, including Overtime, adjustments, and taxes,
as well as the markups of any subcontractors to this
contractor.)

Contractor Cost
Fields

The following fields in the grid are the Contractor Cost
fields defined for this estimate. Each field shows the
current markup percentage or amount as defined for this
contractor. (These values are defined in the Contractors
primary view, using the Contractor form.)

Tier

The position of this contractor in the contractor
hierarchy. Prime indicates a prime contractor. Other
values are 1st tier sub, 2nd tier sub, etc.

Own Work

Amount of the Work figure representing this contractor's
own work

Subbed Work

Amount of the Work figure representing work that this
contractor subcontracts

Tasks Grid

This grid on the tab shows all tasks under the current
folder to which the selected contractor is currently
applied. The tasks are shown with their parent folders
and associated Tags.
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Owner Markups
In M32, Owner markups are used to estimate costs to the project owner outside of
construction contracts. They are applied after all other markups. Owner markups
may include escalation, contingency, supervisory costs, and so on. Like other
markups, they are distributed over all or part of a project.
Some Owner markups, such as Escalation, are normally defined at the top-level
folder and thereby applied to the entire estimate. Others, such as Contingency
markups, may be applied only to certain folders or tasks. The recommended
procedure is to apply the top-level markups first and then to apply any additions or
exceptions at the lower level folders or tasks.
You define Owner markups on the Owner tab:

Owner Markup
Type

This area in the upper left part of the tab shows all of the
Owner Cost types defined for the estimate on the Select
Fields tab of the Project Summary Information dialog.
The currently selected type is shown by the

icon.

For More Information on the Owner Cost fields, see
Chapter 4.
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Definition Grid

The rows in this grid (in the upper right of the tab) shows
all of the markups defined in the estimate for the
currently selected Owner Cost type. For example, if
three different Contingency markup percentages are
defined for three different areas of the estimate, all three
are shown in the grid. The currently selected markup is
shown by the selection icon

.

Count

Number of tasks under the currently selected folder to
which this Owner markup is applied

Description

Description of the markup. Typically includes the
percentage added or deducted and the Owner Cost
field.

Method

Method used to compute the Owner markup. See “Cost
Methods” below for information.

Percent

Actual markup percentage applied. Depending on the
Method, you may enter the percentage here or M32 may
compute it.

Amount

Amount of markup for this Cost field.
Note: Depending on the Method, either an Amount or
Percentages may be used.

Tasks Grid
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This grid area on the lower part of the tab shows all
tasks under the current folder to which the selected
Owner markup is applied. The tasks are shown with
their parent folders and the associated Tags.
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Escalation
Fields

These fields appear at the bottom of the tab when you
select Compute Escalation as the Method for the
predefined Escalation Cost field. You enter Escalation
table values that M32 then uses to compute an
escalation percentage to apply as the markup.
Escalation tables are available from a number of
industry and government sources, such as:
•
•
•
•
•

R.S. Means Company
Engineering News Record
F.W. Dodge
U.S. Government Office of Management and Budget
U.S. Army Corps of Engineers (Form AR 415-17)

Note: The Date of the Escalation Schedule is printed in
the Project Settings Report and the Markups Report.
See Chapter 9 for more information on Reports.
Start Date

Date represented by the Index in the next field.

Index

Index at which to begin calculating Escalation costs.

End Date

Date represented by the Index in the next field.

Index

Index at which to end calculation of Escalation.
The End Index is divided by the Start Index to compute
an escalation factor representing the relative cost
change between the two indexes. This factor (minus
one) is then applied as a running percentage to yield the
percentage value for the Escalation field.

M32 Reference Manual

201

Chapter 8 : Cost M arkups and Adjustments

Methods
M32 supports these methods of computing Owner markups. As indicated, certain methods
are only available for certain of the predefined Owner Cost fields.
• Direct Pct - M32 calculates the markup using the percentage you enter in the Percent field
times the total contract costs only (that is, total Direct plus all markups up to the "Cost to
Owner" row as shown on the Summary tab). M32 excludes other Owner Costs from the
computation. This option is available for all Owner Cost fields.
• Running Pct - M32 calculates the markup using the percentage you enter in the Percent
field times the running total. The running total is the total of all Direct Costs and markups
including any Owner markups listed above this one on the Summary tab. This option is
available for all Owner Cost fields.
• Amount - M32 adds the amount you enter in the Amount field. This option is available for
all Owner Cost fields.
• Compute Escalation - M32 computes the percentage based on Escalation data that you
enter on the bottom of the tab. Available only for the Escalation Cost field.

Actions
You can take the following actions on the Owner tab:
• To apply an Owner markup to the current folder or task, select the Owner Markup type,
select a row in the Definition grid, then click the Apply button.
• To add a new markup percentage or amount, first select the Owner Markup type, then
click a blank row in the Definition grid and enter a Description, Method, and Percentage or
Amount.
• To change information about an Owner markup , select the markup and change the data
in the Definition Grid.

Example - Defining a Contingency Percentage
In this example, you need to define a 6% Contingency for the Sitework in an estimate. You
want this markup applied after Escalation. You have already defined Escalation and
Contingency as Owner markup types on the Select Fields tab of the Summary Information
dialog. (Contingency is entered as a User-Defined Owner field.)
1

In the tree panel, highlight the Sitework folder.

2

Choose View > Form > for Markups.
The Markups form is displayed.
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3

Click the Owner tab.

4

Click to select the Contingency type in the Owner Markup Type grid.

5

Click in the Definition grid and enter the following information:

6

Description

6% Contingency for Sitework

Method

Running Percentage

Percent

6%

Click the Apply button.
M32 applies the 6% Contingency percentage to all Sitework tasks. The markup is
applied to Escalated contract costs for the work.
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